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Online Mapping Primer

• Geographic Viewers and Geographic Exploration Systems

• InFOREST

• Google Earth Pro
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Geographic Viewers/Exploration Systems

• Allow for exploration of spatial data

• Base imagery and data are already collected

• Sharing of spatial information and files

• KML/KMZ files can be created and shared

• Allows users to create maps

• Print/download maps using built in templates

• Often free

• Google Earth Pro is now freely available!
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InFOREST

• http://inforest.frec.vt.edu/

• Basemaps and imagery

• Area, location, and distance measurements

• Annotation

• Printable map templates

• GPS point tool

• Runs through website, no need to download
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Google Earth Pro

• Need to download and install program

• Basemaps and imagery available

• Measurement of location, distance, and now area

• Geocoding available

• Printable maps

• Use with KML, KMZ

• Can open shapefiles (.shp)

• New with Google Earth Pro: area function, demographic data, 
shapefile use, better quality printing, geocoding
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InFOREST website

• Expand Map 
button

• Click to use 
full screen
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Search for location

• Address

• Place

• Point of Interest

• Geographic coordinate

• For this exercise: 

• Kerr Pl, Culpepper, VA
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Navigation of map in viewer

• Zoom in

• Go to home location (centered 
over Virginia)

• Zoom out

• Go back to last view

• Go forward to more recent view

• Information/help
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Map tools menu

• Click on any “�”to expand that 
menu option

• Click on any “�” to minimize 
that open option

• Map tools allow for changes in 
layers and basemap, 
measurement, annotation, and 
map export
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Change basemap to imagery

• Expand the “switch basemap” 
tool and select “Imagery”
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InFOREST website with basemap imagery
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Measurement tool

• Measure/coordinates has three 
options

• Measure area

• Measure distance

• Find point coordinates
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Measurement tool: area

• Left-click around the 
outside of the area you 
want to measure

• InFOREST will attempt to 
“complete” the polygon as 
you go

• Double click when you are 
finished

• Display of measurement 
result in toolbox
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Measurement tool: length

• Left click along the 
feature you want to 
measure

• Double click to 
finish segment

• Results located in 
toolbox

• Hint: use multiple-
close-together 
points to follow a 
curve or other 
complicated feature 
edge
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Change units for measured feature

• Drop down allows for change in 
units

• Can change units after drawing 
feature (and without redrawing)

• Automatically updates 
measurement results
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Measurement tool: coordinates

• Left-click on point to 
find coordinates

• Make sure coordinate 
button is “pressed 
down” before clicking

Online Mapping Primer 16



4/3/2015

9

GPS Toolkit

• Can

• Manually draw 
Point/Multi-points

• Auto-plot points in 
an area

• Enter coordinates 
and it will plot 
points

• Use “Draw” button 
before starting to 
add points
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GPS Toolkit: points

• Select point or multi-point from 
drop down menu

• Press draw button

• Draw points on map by left-
clicking. Double click on last point.

• Clear points using “clear map” 
button

• Select a file type for exporting from 
the drop down menu

• Either send the file by email or 
download the file (in zipped 
format)
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GPS Toolkit: auto-plot

• Generate a set of points in an area

• Either freehand the area or click the 
vertices of the polygon

• Uniform grid or random points option 

• Select options

• Draw shape

• Let InFOREST generate points

• Export point file for use
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GPS Toolkit: auto-plot

• Select options

• Freehand with 
left mouse 
button held 
down

• InFOREST will 
automatically 
close shape 
when you release 
button
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GPS Toolkit: auto-plot

• With polygon drawn and options selected, 
click “generate”

• Then select how to export

• Tips:

• Only 500 points can be generated in a 
polygon, so adjust the grid distance as 
necessary or use multiple polygons to cover 
the area

• GPX functionality is currently being worked on

Online Mapping Primer 21

GPS Toolkit: auto-plot generation

• Map display will 
update when 
generation in 
complete

• Here, the grid 
distance was 
updated to 50 to 
avoid having to 
many points and 
receiving an error 
message
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Export auto-plot

• Shapefiles, KMLs, and KMZs can 
be used in Google Earth Pro!

• Select to email or download the 
file

• File will be zipped
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***GPS Toolkit: points

• Click “Draw”

• Draw points 
around the 
parcel seen on 
screen

• Double click to 
close polygon
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***Download KML file

• Select KML from the drop down 
menu

• Download the file
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***Download .shp

• Select .shp from the drop down 
menu

• Download the file

• Take both the KML and the .shp
and unzip the files for future use

• Be aware that shapefiles have 
multiple file components… keep 
them all in a file together to be 
safe!
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Annotate Map: shapes 

• Select options for shape
• Shape type (freehand vs 

vertices, multi 
point/segment vs individual)

• Fill and line color

• Fill and line 
translucence/opacity

• After selecting options, 
select “draw” and left click 
around feature, double 
clicking to close polygon or 
end line
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Annotate Map: text

• Select options for text

• Type text in “text” box

• Preview text

• Add to map at point
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Export map

• Input title, notes about map

• Select file type (pdf, jpg etc)

• Select page size and layout

• Select scalebar units

• Select “print”
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Sample InFOREST printed map

• Retains annotations

• Gives information about imagery 
sources
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Google Earth Pro

• Opening screen

• Can hide the 
“Tour Guide” to 
get more map 
space (click the 
down arrows 
along the tour 
ribbon)
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Navigation

• Hover over the 
navigation 
tools on the 
left to make 
them visible

• Double click in 
map to zoom 
in

• Drag map to 
move view
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Navigation Tool

• Drag or hold down the left 
mouse button in the top circle to 
change the orientation from 
North

• Double click the “N” to return to 
normal

• Lower circle: click or drag to 
move map content

• Zoom in or out by dragging the 
marker or clicking the “+” or “-”
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Search for locations

• The Search tool is located in the 
top left of Google Earth Pro

• Search points of interest, places, 
addresses, or latitude/longitude

• Parcel number (APN: Assessor 
Parcel Number) is also available
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Layers

• The layers tool is in the lower left 
hand corner of Google Earth Pro

• Check or uncheck layers and labels 
you are interested in

• Some layers have sub layers: 
expand by clicking the “+”

• Google Earth Pro has more 
advanced layers than Google Earth. 
Expand the “Earth Pro” layer set to 
view demographic, parcel, and 
traffic data
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Reset map view

• If you zoom in too far, 
accidentally change the settings, 
or view certain layer features, 
the view can become “tilted”

• To reset the map view to north 
at the top of the screen and no 
tilt in the imagery view

• Click the “View” menu

• Go to “Reset”

• Click “Tilt and Compass”
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Common tools

• Add Placemark

• Add Polygon

• Add Path

• Add Image Overlay

• Record a Tour

• Show Historical Imagery

• Show Sunlight
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GPS Tool

• You can import GPS files

• Go to the “Tools” menu

• Click “GPS”

• Select settings and import in tool 
interface

• Imports points from unit, unlike 
InFOREST where you can create 
a file to load into the unit
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Search for conference location

• In the search tool, enter 

• “Technology Drive, Culpeper, VA”

• The tool will autocomplete to 
suggest locations as you type
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Woods and Wildlife Conference

• You can adjust 
layers to include 
those of interest

• Zoom in or out to 
preference

• Click the red 
placemark at 
Technology Drive
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Point information

• If you click a symbol on the map, 
an information bubble will 
appear

• Close by clicking the “X” in the 
top right of the bubble
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Other layer symbols

• Click the photo symbol for 
user uploaded pictures of 
features of interest

• Click other layer symbols 
for additional information

• Useful for exploration of 
sites of interest 
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Add a placemark

• Click the “add 
placemark” tool

• Drag the symbol to 
the correct location

• Add information 
and a title

• Change the symbol
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My Places

• “Places” are located in the left 
sidebar

• When you create a place or 
shape, it will appear in the folder 
that was highlighted
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Edit placemark

• Right-click the placemark in the 
“Places” sidebar

• Go to “Properties”
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Edit Placemark

• Change the location of 
the pin by dragging it 
on the map with this 
tool open

• Change the symbol

• Add information or 
pictures

• Change the view or 
zoom level

• Click “Ok” to save 
changes
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Place options

• Right-click a place in “Places” to 
view options

• Get directions to or from a place

• Email a place
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Open an existing KML or KMZ 

• Open the KML we created in 
InFOREST

• Go to “File”

• Select “Open”
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Open a KML

• The “Open” window will appear

• Navigate to the location of the 
saved KML

• Select the Google Earth file type

• Select the file

• Click “Open”
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Opened KML

• The map will open, 
pan to, and show 
the KML selected

• Notice which Place 
folder the file is in

• Add a placemark
here
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Add a polygon

• Select the “add a 
polygon” tool

• The attributes menu is 
similar to the placemark
menu

• Left-click around the 
polygon

• Google Earth Pro will 
attempt to “close” the 
polygon as you go

• Click “OK” to finish
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Edit polygon vertices

• To edit vertices, click the 
vertex you are interested 
in moving

• Drag the vertex to the 
desired location or click a 
new location

• You can do this while 
creating or editing a 
polygon

• You can also select a 
vertex and use the 
“delete” key to remove it

• Right click to remove the 
highlighted vertex
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Polygon style

• Select line color, line width, and 
line opacity

• Select fill color, style, and 
opacity
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Measurement tab in polygon

• Select the measurement tab in 
the polygon properties menu

• Google Earth Pro offers the 
ability to measure area!

• Use the drop down menu to 
change units of measure
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Place Folders

• Left click and drag a place to a 
different folder to sort or make 
permanent

• Right-click “My Places,” select 
“Add,” then “Folder” to create 
new folders to sort and save 
your places
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Add a path

• Left-click along the path 
you wish to create

• The most current vertex 
will be highlighted

• You can select previous 
vertices and edit them 
by dragging them

• If you wish to add a 
point in the middle of 
the path, select a vertex 
that will be before the 
point you want to add, 
then click where the 
new vertex will be 
located
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Path tabs

• Select the measurement tab

• The path length will be given

• Use the drop down menu to 
change unit

• Select the “Style, color” tab to 
change the path style. Similar to 
the style options for polygons.
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Zoom out

• Zoom out so the 
polygon, path, and 
Woods and Wildlife 
Conference 
placemark are all 
within view
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Ruler tool

• Select the “ruler” 
tool from the top row 
of tool icons

• Select the “line” tab

• Click the Kerr Place 
location and measure 
the line to the 
conference 
placemark

• Use the drop down 
menu to select units 
of measure
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Other Ruler options

• Use “Line” for as the crow flies

• Use “Path” to measure a path 
with multiple vertices

• Use “Polygon” for area and 
perimeter

• Use “Circle” and click the middle 
of the circle and the radius

• Use “3D path” and “3D polygon” 
for measurements that take 
topography into account
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Save Places

• Select the “File” menu

• Click “Save”

• Save Place As: save the highlighted 
place

• Save My Places: saves your work 
so you can use it in another 
session
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Save Place As

• Save the selected place

• Select the folder to save in

• Give the place a file name

• Select the file type (KML or KMZ)
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Historical Imagery tool

• Select the “Historical Imagery” 
tool

• The tool will appear in the upper 
left corner of the map

• The date of the viewer’s imagery 
is shown

• Slide the marker or click the 
rewind or fast forward buttons 
to view different dates
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Land Cover Change

• Double click the 
polygon you 
created in “my 
places”
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Land Cover Change

• Press the rewind 
button on the historical 
imagery tool to go back 
until you see the area 
before it was cleared

• Check the date of the 
imager
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Land Cover Change

• Go to the 
neighborhood roads 
you created a path 
for

• See when they were 
built
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Historical Imagery uses

• Land use change/dates

• Leaf on/leaf off imagery to 
distinguish evergreen/deciduous

• Differentiate between 
pine/hardwood areas with imagery 
dates (digitize by creating 
polygons)

• Google Earth imagery only goes 
back so far

• Dates available are limited
• May not capture changes between 

dates
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Tools

• Email

• Print

• Save Image

• View In Google Maps
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Email Map

• Attach a .jpg screen shot of the 
current view in an email

• Send a KML file that will open the 
current view as an attachment

• Send a KML of the selected places

• Will need to sign in to your email 
account to use this option

• Can personalize the message and 
select recipients
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Emailed: current screen shot

• Automatic text option 
for email

• Attachment is a .jpg
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Print Map

• Drag map view to 
preference

• Select map 
options, page set 
up, and print 
options

• Select to send to a 
printer or save as 
a PDF
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Edit map elements

• Hover over the title 
or legend and click 
when the pencil 
appears

• Check elements that 
you want to appear in 
the legend

• Change the title and 
notes for the map
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Printed Map

• The PDF or printed version will 
look the same

• If using pdf, you will be asked 
where to save the file and what 
to title it

• Notice the white space around 
the map
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Save Image

• Edit the same way 
you edited the map 
for “print map”
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Saved Image

• You will be prompted 
to select a file 
location, title, and 
format to save

• Notice there is no 
white space around 
the map image
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Viewed in Google Maps

• Select this option to 
open your current 
view in an internet 
browser

• You can copy the 
address

• Notice that your 
places do not show 
up in Google Maps

• You can do this by 
posting your places 
to Google Earth 
Community Forums 
(right click place and 
see options)
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Closing Google Earth Pro

• When you close Google Earth 
Pro, you may have unsaved 
items in “Temporary Places”

• Be sure to check this folder 
before closing to decide whether 
to save them in “My Places” or 
whether to discard them
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Additional Geocoding tutorial

• Google Earth Pro has the option 
of adding placemarks for an 
entire file of addresses

• See the tutorial:
• https://support.google.com/earth

/answer/176685?hl=en

• The tutorial includes a sample 
file to work with (linked in 
tutorial)

• http://services.google.com/earth/
samplefile.csv

Online Mapping Primer 78



4/3/2015

40

Questions?

• Contact information

Katie Britt

kcorrell@vt.edu
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